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The Presensational Learning Template Slides package contains three PowerPoint® files that 

together help you quickly and easily begin creating courses in PowerPoint and present them in 

the classroom or publish them for Web delivery using a variety of conversion tools. These files 

include a course structure template (horton_course_template.potx), a lesson structure template 

(horton_lesson_template.potx), and a topic template (horton_topic_template.potx). Note: The following 

instructions are written for PowerPoint 2010. They assume you are familiar with this program 

and can perform common procedures. If you need a refresher, take a look at the section Review 

the basic PowerPoint skills you will need starting on page 33. 

ACCEPTABLE USE 

What can you do with these templates? In case you skipped over the legal agreement, or just 

don’t remember the details, let’s review. You can use these templates to build slide presentations. 

You can then show those presentations as often as you like. You do not have to credit our 

templates, though we would not object. You can let other people show your presentations. Only 

the person creating and editing the slides needs to buy a copy of our templates. 

Only the person who bought these template slides can use them to create content. You cannot 

give these templates away to others. Nor can you resell them either as is or part of your own 

template package. 

HOW THE TEMPLATES WORK TOGETHER 

Using the three templates, you can easily 

build a complete course.  

1. Open a new course structure file 

(horton_course_template2010.potx. 

2. Add lessons to the course 

(horton_lesson_template2010.potx). 

3. Add topics to lessons 

(horton_topic_template2010.potx). 

4. Add content to the topics. 

5. Add tests and quizzes at the 

course, lesson, and topic level. 

6. Connect the course menu (optional). 

7. Save, test, and refine the course. 

Let’s look at these steps in more detail: 

1. Open a new course structure file 

Find the Presensational_Template_Slides directory you downloaded containing the three template 

slide files. Note: If you purchased the Get-It-All-Pack, you have a fourth template named 

horton_content_template2010.potx. 
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Click on horton_course_template2010.potx to start PowerPoint and open a new course structure file. 

Before going further, save this file. 

2. Add lessons 

Find the lesson placeholder slide. This slide marks the spot where you should insert lessons from 

horton_lesson_template2010.potx. Here’s how: 

1. Click the Home tab  

2. Click the downward-pointing arrow next to the New Slide button in the Slides section of 

the Home ribbon. 

3. Choose Reuse Slides… at the bottom of Office Theme window.  

4. Click the Browse button and choose Browse File…. 

5. Navigate and choose horton_lesson_template2010.potx. (The slides in the selected 

presentation will appear in the Reuse Slides panel.)  

6. Check Keep source formatting. 

7. Click the thumbnail of each slide you want to insert – in the order you want to add them. 

(No, there is no way to select all of the slides and insert them in one action.)  

8. Repeat for each additional lesson. 

9. Delete the placeholder slide. 

3. Add topics 

Within each group of lesson slides is a topic placeholder slide. This slide marks the place where 

you should insert topic slides from horton_topic_template2010.potx. Here’s how: 

1. Click Home  New Slide. 

2. Choose Reuse Slides….  

3. Click the Browse button and choose Browse File…. 

4. Navigate to and choose horton_topic_template2010.potx. (The slides in the selected 

presentation will appear in the Reuse Slides panel.)  

5. Check Keep source formatting. 

6. Click the thumbnail of each slide you want to insert – in the order you want to add them. 

(No, there is no way to select all of the slides and insert them in one action.)  

7. Repeat for each additional topic. 

8. Delete the placeholder slide. 

4. Add content 

Within each topic is a content placeholder slide. At this point in the topic, you should add your 

instructional content. You can do that in two ways: 

From scratch 

1. Click Home  New Slide. 
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2. Choose one of the layouts displayed. 

3. Add text, graphics, animation, sound, music, and other media to express the ideas you 

are trying to communicate. 

4. Repeat for additional content slides. 

5. Delete the content placeholder slide. 

By modifying a template slide (sold separately) 

You can save time by inserting pre-built, animated slides from the Presensational Content 

Template Slides (sold separately at www.horton.com/ppttemplates.aspx). This file contains over 

340 animated slides you can modify and use to express all kinds of information. 

1. Click Home  New Slide. 

2. Choose Reuse Slides….  

3. Click the Browse button and choose Browse File…. 

4. Navigate and choose horton_content_template2010.potx. (The slides in the selected 

presentation will appear in the Reuse Slides panel.)  

5. Check Keep source formatting. 

6. Click the thumbnail of each slide you want to insert. 

7. Delete the content placeholder slide. 

Note: There are extensive instructions included in the notes field of the Presensational Content 

Template Slides. And, there is a Quick-Start Guide to get you up and running quickly. 

5. Add tests and quizzes 

The course, lesson, and topic templates contain placeholders for pre-tests, post-test, and quizzes. 

If you decide to include such assessments, here are some options to consider: 

 Build your tests and quizzes within the tool you will use to convert the PowerPoint slides 

to a Web-ready format, such as Flash. There are several tools to consider, including 

Adobe Presenter, Articulate Presenter, and iSpring Presenter. 

 Link to tests prepared in another tool, such as Macromedia Captivate or Hot Potatoes, 

link to tests hosted by a testing service, such as HostedTest.Com, or link to tests created 

and hosted on your LMS (learning management system) or LCMS (learning content 

management system). 

 Use informal self-check activities created directly in PowerPoint. There is a selection of 

such slides in the Presensational Content Template slides package. 

For more detailed instructions see Include quizzes on page 30. 

6. Connect the course menu 

If including a course map, go to the Course Map template slide and follow the instructions in its 

Notes field. Don’t forget to copy the Course Map button to the slide master. 

http://www.horton.com/ppttemplates
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7. Save, test, and refine 

Now that you have added lessons, topics, and content to your course, save the newly created 

PowerPoint file.  

Before going further, review the file in Slide Show view (F5). If you are planning to use this 

course on the Web, convert the file using your chosen conversion method. Carefully review the 

results to ensure that slide objects appear as expected and animate smoothly. 

THE COURSE TEMPLATE—A DEEPER LOOK 

The course template (horton_course_template2010.potx) provides a structure you can use to quickly 

and easily build a course. Simply use the slides you need and delete the rest. Replace the text, 

graphic, and content placeholders and you are ready to take it into the classroom. If you are 

creating e-learning, add narration and then publish for delivery over the Web.  

Organization 

Here is an overview of the slides included in the template file. Each slide is discussed in more 

detail under the section Individual slides and notes starting on page 8. 

 

Please, before you begin editing the course template slides, play them in Slide Show view (F5) to 

see the animation effects that are built in. 
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Individual slides and notes 

Here are the individual slides in the course structure file (horton_course_template2010.potx). The 

notes to the right are the same as those in the Notes field of the PowerPoint slide. 

 

The Course title slide identifies the course. It helps learners 

confirm that they have launched the right course and 

motivates them to dive right into learning. 

Replace the Course title placeholder with the official name of 

the course. It should be the same as the one the learner 

selected to launch the course. 

In naming your course, strive for a short name that clearly 

communicates what the course does for the learner. Use 

terms that the learner will recognize before taking the course. 

Use the Course subtitle placeholder to elaborate on the title. 

Make the subtitle up to three lines long. 

Add any notices the learner must see before continuing, for 

example, a safety warning or the requirement for a security 

clearance. 

 

Before plunging into a course, potential learners need 

information and orientation. Use the About the course 

section to prepare learners to learn. Here you will find 

template slides for much of what learners need to know 

before commencing learning. We have been generous with 

template slides here. Feel free to delete ones you do not need 

in your situation. For a simple, short course, you may need 

only a few of the template slides in this section. 

 

Unless learners can navigate your course, they are not going 

to learn. Include a slide or two to how to get around.  

Because the exact user interface and navigation methods will 

depend on your conversion process and tools, this template 

can only offer general suggestions. Some tips: 

 Create this slide after other aspects of your course are 

stable. Otherwise the pictures will not be accurate. 

 Replace graphics with snapshots from your course. 

 Include generic instructions based on the user-interface 

provided by your conversion process. 
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People are naturally curious about people, especially people 

they are asked to trust and rely on for their own success. Use  

the Your instructor slide to:  

 Put a face and a personality with the name of instructor.  

 Establish the authority and credibility of the instructor 

and hence the course.  

 Capitalize on the fame or reputation of the instructor 

associated with the course. 

Use a photograph that shows the instructor doing something 

relevant, rather than the typical drivers-license photo. 

Edit the description at the right of the photo to highlight the 

qualifications of the instructor. An academic audience may 

be more impressed with degrees and publications while an 

industry audience may be more interested in successful 

projects and awards. 

Along with the instructor, you might want to introduce the 

course author, narrator, or primary subject-matter expert. 

 

You may want to include a description of the course. The 

Course description slide should serve as a reminder of the 

complete course description learners should have read before 

enrolling.  

Other items your may want to include are: 

 Fee 

 Version 

 Date 

 Language 

 Special bonuses or incentives 

 Style of learning (WBT, blended, virtual classroom, 

classroom) 

 Alternatives, e.g., for accessibility. 

Remember to edit the e-mail. To do that:  

1. Select the e-mail address. 

2. Right-click and choose Edit Hyperlink…. 

3. Edit the e-mail address. 

4. Click OK. 
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Unprepared learners are cruising for disappointment. Before 

you let learners get too far into the course, inform them of 

what skills, knowledge, and attitudes they need in order to 

take advantage of your course. 

Use the Course prerequisites template slide to tell learners 

what the course requires. As a courtesy, tell learners how 

they can meet the prerequisites. If possible, include links to 

other courses or Web sites where learners can start learning 

the prerequisites. 

To link to a Web address: 

1. Select the text to be the link trigger. 

2. Right-click and choose Hyperlink…. 

3. In the Link to: section of the dialog box, click the 

Existing File or Web Page button. 

4. In the Address field enter the URL of the resource. 

5. Click OK. 

 

Include a Copyright notice and usage policy slide if you are 

concerned with protecting the intellectual property of your 

course. Such a slide may not be necessary if ownership is 

simple and you have edited the copyright notice on the slide 

master. 

Use this template slide when: 

 Your course includes material you are using with 

permission of its owner. 

 Learners may need to make a backup copy of the 

course. 

 You want to allow controlled reproduction of the 

course. 

Don’t forget to edit the hyperlinks so they point somewhere 

meaningful. Just point to one of the links, right-click, and 

select Edit Hyperlink ….  

Or if you feel that the hyperlinks will prove too much of a 

distraction or will lead learners out of the course, right-click 

each link and select Remove Hyperlink. 
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Sometimes you need a legal gateway to ensure that learners 

agree to abide by certain rules of conduct. The Terms and 

conditions template slide both informs learners of these 

conditions for taking the course and prompts them to accept 

them.  

Terms can concern issues such as: 

 Not making illegal copies of the course. 

 Not revealing passwords or answers to test questions. 

 Behaving professionally toward others. 

If your terms and conditions will not fit a single slide, create 

a complete document and include a link to the document 

from the slide. 

Note the buttons are set as follows: Clicking I do not agree, 

quits the course. Clicking I agree, continues with the next 

slide. Of course, you will need to test these with your 

conversion process, as they do not work with all conversion 

tools. If the buttons do not work after conversion, replace 

them with a statement that the leaner should not continue 

without agreeing to the terms and conditions. 

And be sure to have this slide reviewed by your legal 

department. 

 

If the course is graded, tell learners what the grade means 

and how it will be calculated. 

In the introduction, tell learners clearly that a grade is 

calculated and recorded. Tell them how this grade affects 

them. For example, is it used to qualify them for a particular 

job or for enrollment into an advanced course? 

Then, spell out the formula used to calculate the total course 

grade. Components might include: 

 Quizzes 

 Exercises 

 Discussions 

 Projects 
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If the course has a textbook (or other primary reference 

work), use the Textbook template slide to introduce it. A 

plain old paper textbook might seem an anachronism in an e-

learning course—or it might be a lifeboat for learners not yet 

accustomed to e-learning media and procedures. 

Also, if your course closely follows a textbook, use textbook 

readings for the informational component of your course. 

Then, target your e-learning efforts at creating engaging 

activities to lock in the concepts learners have read about. 

 

Use the Course outline template slide to provide a concise 

overview of how the course is organized and to preview the 

sequence in which learning experiences will occur. The 

Course outline template slide is an alternative to the Course 

map template slide. 

If you need more space for the outline, delete the placeholder 

for the graphic and duplicate the placeholder for the outline. 

If you want to use the course outline as a table of contents or 

menu, hyperlink each line in the outline to the first slide of 

the corresponding section. 
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The Course map helps learners see the “big picture” 

organization of your course. If you add hyperlinks to the 

map icons, it can also help learners quickly move around in 

the course by clicking the appropriate icon on the map. To 

return to the map, learners click the map button in the lower-

left corner of the slide. 

After you have completed your course, you will need to add, 

remove, or rearrange the icons, arrows, and the white boxes 

beneath the icons depending upon the content of your 

course. Then you will need to add or edit the hyperlinks on 

each icon. To link an icon to a specific slide: 

1. Select the icon. 

2. Right-click and choose Hyperlink…. 

3. In the Edit Hyperlink dialog box, click the Place in 

This Document button. 

4. In the list that appears, expand the Slide Titles list. 

5. Choose the slide name from the list. 

6. Repeat for each icon. 

7. Copy and paste the Course Map button onto every 

slide. You may want to add it to the slide and title 

master, too. 

For more, search for “About hyperlinks and action buttons” 

in the PowerPoint Help. 

 

The Course pre-test helps learners decide if they should 

continue this course. If learners score too low on the pre-test, 

they lack prerequisite knowledge. If they score high, they 

may want to skip this course. 

The pre-test can also be used to motivate learners by 

showing them that they do not yet know the subject and by 

arousing their curiosity about the subject. 

Note: The Lesson template has placeholders for a lesson pre-

test. If you do your pre-testing at the lesson level, you can 

delete the template slides of this section. 
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The Course pre-test introduction slide announces the course 

quiz and provides information the learner needs to begin the 

quiz. This slide covers the rules specific to the individual 

quiz.  

 

 

Here you will need to insert a test. The way you do that 

depends on how you will be converting your slides for 

online delivery. Here are some options: 

 Use a conversion tool such as Articulate Presenter, 

Adobe Presenter, or iSpring Presenter to insert a quiz 

right into your PowerPoint slides. 

 Link to a test created in a separate tool, such as Adobe 

Captivate or Hot Potatoes. 

 Link to tests created and hosted on your LMS (learning 

management system) or LCMS (learning content 

management system). 

 Link to a testing service such as HostedTest.com. 

 Include some self-check activities from the 

Presensational Content Template Slides (sold separately). 

If you take this route, be sure to tell learners how to 

score themselves. 

For more information, see Include quizzes on page 30. 

Delete this placeholder slide. 

 

Use the Course pre-test results template slide to help 

learners decide whether to continue with this course. This 

slide lists three ranges of scores: passing, marginal, and 

failing. For each it suggests what learners should do. 

Note: Take care to link to the course summary, not to the 

summary for an individual lesson or topic. 

If you deleted the Course prerequisites slide, remove the 

hyperlink for “prerequisites” and provide and alternative 

activity learners should perform. 
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 This slide is just a placeholder to show where to insert the 

lessons. Replace this slide with the lesson template slides: 

1. Click Home  New Slide.  

2. Choose Reuse Slides….  

3. Click the Browse button and choose Browse File…. 

4. Navigate and choose horton_lesson_template2010.potx. 

(The slides in the selected presentation will appear in 

the Reuse Slides panel.)  

5. Check Keep source formatting. 

6. Click the thumbnail of each slide you want to insert – 

in the order you want to add them. (No, there is no 

way to select all of the slides and insert them in one 

action.)  

7. Repeat for each additional lesson. 

8. Delete this slide.  

 

The Course post-test helps learners verify that they have met 

the objectives of the course. In addition, the course post test 

may be needed by your organization to document that 

learners have mastered the course content. 

 

The Course post-test introduction slide announces the 

course test and provides information the learner needs to 

begin the test. This slide covers the rules specific to the 

individual test.  
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Here you will need to insert a test. The way you do that 

depends on how you will be converting your slides for 

online delivery. Here are some options: 

 Use a conversion tool such as Articulate Presenter, 

Adobe Presenter, or iSpring Presenter to insert a quiz 

right into your PowerPoint slides. 

 Link to a test created in a separate tool, such as Adobe 

Captivate or Hot Potatoes. 

 Link to tests created and hosted on your LMS (learning 

management system) or LCMS (learning content 

management system). 

 Link to a testing service such as HostedTest.com. 

 Include some self-check activities from the 

Presensational Content Template Slides (sold separately). 

If you take this route, be sure to tell learners how to 

score themselves. 

For more information, see Include quizzes on page 30. 

Delete this placeholder slide. 

 

Use the Course post-test results template slide to help 

learners decide whether they met their objectives. This slide 

lists four ranges of scores. For each it suggests what learners 

should do. 

Notes: 

 Link Re-take the course to the first lesson. 

 Make sure Summary links to the course summary, not 

the summary for an individual lesson or topic. 

 If you deleted the Course prerequisites slide, remove 

the hyperlink for “prerequisites” and provide an 

alternative activity for learners to perform. 

 

The Onward section concludes the course making sure 

learners got the main points and can continue their learning. 

This section also acknowledges hard work by those who 

created the course and the student, who took it. It includes 

template slides for a summary, references, credits, and a 

diploma. 
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Use the Course summary slide to recap the most important 

points of the course. Keep the points short and easy to 

remember. 

Summarize the content in short sentences or phrases. If a 

summary item is more than a few lines long, left align its 

text. 

Compare your Course summary slide to your Course 

objectives slide. The summary should not just restate the 

objectives, but should contain the key points necessary to 

accomplish those objectives. 

If you have more than five or six important points, consider 

breaking the course into multiple courses or reducing the 

coverage of the course. 

 

Use the References – For more slide to provide learners with 

suggestions on how to continue learning about the subject of 

this course.  

Add or remove elements as needed. If you add additional 

elements, such as images or text, remember to give each 

element a Fade or some other animation effect. And, be sure 

to check the order each item appears using the Custom 

Animation panel (available from the Animation ribbon). 

Consider referring learners to job-aids, online discussion 

forums, blogs, knowledge bases, help desks, Webinars, and 

other sources of knowledge. To make links open referenced 

Web sites:  

1. Select the text you want as a link.  

2. Right-click and choose Hyperlink… or type Ctrl-K.  

3. Enter the Web address in the Address field.  

4. Click OK. 

 

Use the Course sponsor slide to tell learners who created or 

offers the course. Don’t get egotistical, but do present the 

credentials of the group providing the course. 
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Use the Credits slide if you wish to recognize the individuals 

who contributed to your course. 

 

Congratulate learners and leave them with a warm feeling 

and a sweet taste upon successfully completing the course.  

Here is an idea: Prepare a real certificate in Microsoft 

Publisher or other program and save it as an Adobe PDF 

document. Then, provide a hyperlink on this slide that 

learners can click to open the PDF document. From the 

Adobe Acrobat window, they can print the certificate to their 

local printer.  Or ... 

If learners log in to an LMS to access your course, then you 

may be able to pair that log-in information with the learner’s 

name and dynamically insert the name into a placeholder in 

the certificate. You will need to talk with your IT department 

to see what is possible. 

THE LESSON TEMPLATE—A DEEPER LOOK 

The lesson template (horton_lesson_template2010.potx) provides structure for the lessons in your 

course. As with the course structure template, simply use the slides you need and delete the rest. 

Replace the text and graphic placeholders, and add your topics.  

Organization 

Here is an overview of the slides included in this template file. Each slide is discussed in more 

detail under the section “Individual slides and notes” on page 19. 
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Before you begin editing the lesson template slides, play them in Slide Show view (F5) to see the 

animation effects that are built in. 

Individual slides and notes 

Here are the individual slides in the lesson structure file (horton_lesson_template2010.potx). The 

notes to the right are the same as those in the Notes field of the PowerPoint slide. 

 

A lesson is a subdivision of a course and contains several 

topics. 

The Lesson title slide marks the start of a sub-division of 

your course. Use it like you might use a level-one heading 

in a document. 

The Lesson title should be sufficient to communicate the 

lesson’s goal and contents to most learners. 

Keep the title short and use the subtitle (up to three lines) 

to elaborate on the title. A good subtitle will imply what 

the learner gains in this lesson. 

If the lesson accomplishes a specific learning objective, you 

may want to imply that objective in the subtitle. 



Presensational Learning Template Slides 

Copyright © 2005-2010 William Horton Consulting, Inc. All rights reserved. Revised 6/2010 20 

 

The Lesson objectives slide tells learners in detail what 

they will get out of taking the lesson. Use this slide to 

answer questions learners have about what the lesson 

accomplishes and to provide motivation for learners to 

complete the lesson. Do not make a big deal about 

objectives. Just tell people what they will individually gain 

by completing the lesson. 

Include a relevant graphic to show what learners will be 

able to do after completing the lesson. You might, for 

example, show an attractively styled report, a smiling 

team, or a happy customer. 

In the bullet list, tell learners what they will be able to do 

(skill), come to understand (knowledge), or grow to feel 

(attitude). Emphasize benefits that learners will value. Ask 

yourself, “Can learners see how the objectives make them 

healthier, wealthier, or wiser?” 

If your learners are highly visual, consider replacing the 

bullet list with a series of appropriate pictures illustrating 

the outcomes you promise. 

In designing the content of your course, use these 

objectives as a checklist for topics to include. You may 

want to include one topic for each objective. Or, you may 

prefer a less direct approach. In any case, you must create 

content to accomplish each and every objective—or 

remove the objective. 
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The Lesson preview slide prepares learners for the lesson. 

It provides a concise introduction and overview. 

Use the subtitle to introduce the bullet list. Or, delete the 

subtitle. 

Summarize the main points of your lesson using the bullet 

list. Use voice narration to explain each bullet item and to 

elaborate upon it. 

Replace the graphic placeholder with a relevant graphic to 

lock in the concept. The graphic could show an example of 

the concept, a diagram of the concept, or a formula for a 

relationship. 

This slide is very similar to the Lesson Objectives slide. Use 

one or the other—but not both. If your lesson is very 

simple, you may want to omit this slide. Or you may want 

to put the Lesson summary here. If you are using a 

strategy of discovery learning, you may want to omit this 

slide but include a summary near the end. 

 

The Lesson pre-test helps learners decide if they should 

continue this lesson. If learners score too low on the pre-

test, they lack prerequisite knowledge. If they score high, 

they may want to skip this lesson. 

A pre-test can also be used to motivate learners by 

showing them what they do not yet know and arousing 

their curiosity about the lesson content. 

 

The Lesson pre-test introduction slide announces the 

course quiz and provides information the learner may 

need to begin the quiz. This slide covers the rules specific 

to the individual quiz.  
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Here you will need to insert a test. The way you do that 

depends on how you will be converting your slides for 

online delivery. Here are some options: 

 Use a conversion tool such as Articulate Presenter, 

Adobe Presenter, or iSpring Presenter to insert a test 

right into your PowerPoint slides. 

 Link to a test created in a separate tool, such as Adobe 

Captivate or Hot Potatoes. 

 Link to tests created and hosted on your LMS 

(learning management system) or LCMS (learning 

content management system). 

 Link to a testing service such as HostedTest.com. 

 Include some self-check activities from the 

Presensational Content Template Slides (sold 

separately). If you take this route, be sure to tell 

learners how to score themselves. 

For more information, see Include quizzes on page 30. 

Delete this placeholder slide. 

 

Note: Take care that the Summary link points to the lesson 

summary, not the summary for the overall course or for an 

individual topic. 
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Replace this slide with the topic template: 

1. Click Home  New Slide.  

2. Choose Reuse Slides….  

3. Click the Browse button and choose Browse File…. 

4. Navigate and choose horton_topic_template.potx. 

(The slides in the selected presentation will appear 

in the Reuse Slides panel.)  

5. Check Keep source formatting. 

6. Click the thumbnail of each slide you want to insert 

– in the order you want to add them. (No, there is 

no way to select all of the slides and insert them in 

one action.)  

7. Repeat for each additional topic. 

8. Delete this slide.  

 

The Lesson summary section recaps the main points of the 

lesson. Use it to integrate the skills, knowledge, and 

attitudes taught by the separate topics of the lesson. The 

summary is especially important to consolidate learning 

after discovery-learning activities, where each learner may 

have discovered different combinations of the whole 

subject. 

 

Use a Lesson summary template slide to recap the main 

points of the lesson—or at least a part of the lesson. 

If your lesson was long and complex, you may need more 

than one summary slide. Just duplicate this template slide 

as necessary. 
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The Lesson post-test helps learners verify that they have 

met the objectives of the course. And, they may be required 

by your organization to prove learners have mastered 

those objectives. 

Depending upon how you create and deploy the test, the 

slides we include in this section may not be needed. 

 

The Lesson post-test introduction slide announces the 

lesson post-test and provides information the learner needs 

to begin the test. This slide covers the rules specific to the 

individual test.  

 

Here you will need to insert a test. The way you do that 

depends on how you will be converting your slides for 

online delivery. Here are some options: 

 Use a conversion tool such as Articulate Presenter, 

Adobe Presenter, or iSpring Presenter to insert a test 

right into your PowerPoint slides. 

 Link to a test created in a separate tool, such as Adobe 

Captivate or Hot Potatoes. 

 Link to tests created and hosted on your LMS 

(learning management system) or LCMS (learning 

content management system). 

 Link to a testing service such as HostedTest.com. 

 Include some self-check activities from the 

Presensational Content Template Slides (sold 

separately). If you take this route, be sure to tell 

learners how to score themselves. 

For more information, see Include quizzes on page 30. 

 Delete this placeholder slide. 
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Notes: 

You may want to link re-take the lesson to the first topic of 

the lesson, rather than the first slide of the lesson, 

especially if the lesson includes a pre-test. 

You may want to link continue with the next lesson to the 

start of that next lesson. 

Be sure the Summary link points to the summary for this 

lesson rather than the summary for the overall course, 

another lesson, or a topic. 

THE TOPIC TEMPLATE—A DEEPER LOOK 

The topic template (horton_topic_template.potx) provides structure for the topics in your course. As 

with the course and lesson templates, simply use the slides you need and delete the rest. Replace 

the text and graphic placeholders, and then add your content.  

Organization 

Here is an overview of the slides included in the template file. Each slide is discussed in more 

detail under the section “Individual slides and notes.” 

 

Before you begin editing the topic template slides, play them in Slide Show view (F5) to see the 

animation effects that are built in. 



Presensational Learning Template Slides 

Copyright © 2005-2010 William Horton Consulting, Inc. All rights reserved. Revised 6/2010 26 

Individual slides and notes 

Here are the individual slides in the topic structure file (horton_topic_template.potx). The notes to 

the right are the same as those in the Notes field of the PowerPoint slide. 

 

The Topic title slide marks the start of a sub-division of 

your lesson. Use it like you might use a level-two heading 

in a document. 

The topic title should be sufficient to communicate the 

topic’s contents to most learners. Keep the title short and 

use the subtitle (up to three lines) to elaborate on the title. 

A good subtitle will imply what the learner gains in this 

topic. 

If the topic accomplishes a specific learning objective, you 

may want to imply that objective in the subtitle. If the 

actual content of your topic is short, only a slide or two, 

you may want to omit this slide. 

 

The Topic preview/overview slide prepares learners for 

the topic. It provides a concise introduction and sets the 

context of the content that follows. Use the subtitle to 

introduce the bullet list. Or, delete the subtitle. 

List the main points of your topic using the bullet list. Use 

voice narration to explain each bullet item and to elaborate 

upon it. 

Replace the graphic placeholder with a relevant graphic to 

lock in the concept. The graphic could show an example of 

the concept, a diagram of the concept, or a formula for a 

relationship. 

If your topic is very simple, you may want to omit this 

slide. If you are using a strategy of discovery learning, you 

may want to omit this slide but include a summary near 

the end. 
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Now we have come to the actual learning content of your 

course. Replace or edit this slide with content that 

communicate the ideas of the topic. You can: 

From scratch 

1. Click Home  New Slide. 

2. Choose a layout from the window that appears. 

3. Add text, graphics, animation, sound, music, and 

other media to express the ideas you are trying to 

communicate. 

4. Add an appropriate icon to the upper left-hand 

corner. Have you noticed that each type of slide 

has a unique icon? 

By modifying a template slide (sold separately) 

You can save time and insert pre-built, animated slides 

from the Presensational Content Template Slides. This file 

contains over 300 animated slides you can modify and use 

to express all kinds of information. 

1. Click Home  New Slide.  

2. Choose Reuse Slides….  

3. Click the Browse button and choose Browse File…. 

4. Navigate and choose horton_content_template.potx. 

(The slides in the selected presentation will appear 

in the Reuse Slides panel.)  

5. Check Keep source formatting. 

6. Click the thumbnail of each slide you want to 

insert. 

7. Repeat as needed. 

8. Delete this slide. 

 

Use the Topic summary/review template slide to recap the 

main ideas learners should have acquired in the topic.  
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End the topic with a simple activity—a quiz or a simple 

game—so learners can determine whether they 

accomplished the objective of the topic.  

The activity should be short and simple—nothing that 

requires a complex explanation. 

The way you add an activity depends on how you will be 

converting your slides for online delivery. Here are some 

options: 

 Use a conversion tool such as Articulate Presenter, 

Adobe Presenter, or iSpring Presenter to insert an 

activity right into your PowerPoint slides. 

 Link to an activity created in a separate tool, such as 

Adobe Captivate or Hot Potatoes. 

 Link to quizzes created and hosted on your LMS 

(learning management system) or LCMS (learning 

content management system). 

 Include some self-check activities from the 

Presensational Content Template Slides (sold 

separately). If you take this route, be sure to tell 

learners how to score themselves. 

For more information, see Include quizzes on page 30. 

Delete this placeholder slide. 
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STRATEGIES FOR USING THE LEARNING TEMPLATE SLIDES 

You have purchased our template slides. Now you need to make them your own. We suggest 

you do several things: customize the appearance of the template slides to reflect your 

organization’s style guidelines, consolidate the template slide files and re-sequence them as 

necessary, and then add the quizzes.  

Customize the appearance of the template slides 

 Change the copyright notice for the slides, notes, and handouts. From the Insert tab, 

select Header & Footer…. Edit the footer information on the Slide tab and on the Notes 

and Handouts tab. 

 Add your organization’s logo, if necessary. Before adding logos and other identifiers, 

consider how much space they will take away from the content. Also visualize where 

these slides will appear. If they appear within a live presentation, the logos and other 

identifiers will have already been shown on the title slide. If the slides appear within a 

course for the Web, the logos and identifiers will probably already be visible within the 

interface. If you are concerned viewers will have forgotten who owns this information, 

the copyright notice should tell them—not a plethora of irrelevant graphics. 

 Change the theme of the template slides. To do that, from the Design tab choose a new 

theme from the visual menu. You can preview how the new theme will look by simply 

hovering your cursor over each of the themes, For example, here is the original slide: 

 Change just the color and text scheme of the template slides. To do that, from the 

Design tab change the current color pallet, fonts, and effects. To learn more about how to 

choose and modify themes, go to http://office.microsoft.com. Navigate to the PowerPoint 

area of the site and then search using the term “PowerPoint themes.” Choose one of the 

demos to show you how to get started with themes. 

  Add navigation buttons, such as previous, 

next, and course map. These buttons are 

optional depending upon how you want 

learners to navigate through your course. For 

instance, if the conversion method you use to 

publish PowerPoint to a Web-ready format 

provides a table of contents and navigation 

controls, then you may not wish to add them 

to your course. Sample buttons are available 

in the Presensational Content Template Slides 

 

You can add these buttons on the slide and title masters or on 

each individual slide. Your choice will depend upon what 

conversion method you use. If you do add navigation 

buttons, be sure they appear on any new content you add to 

your course. 

http://office.microsoft.com/
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Consolidate templates 

If your courses follow a common pattern, you can streamline production by consolidating the 

three levels of templates into one. For example, if most of your courses have about five lessons of 

six topics each, you would: 

 Open the lesson template. 

 At the appropriate place, insert the topic template six times. 

 Save the modified lesson template. 

 Open the course template. 

 At the appropriate place, insert the modified lesson template five times. 

 Save the modified course template. 

Include quizzes 

PowerPoint does NOT provide a mechanism to build scored or tracked quizzes or tests. You 

must link to assessments created and hosted elsewhere or use capabilities provided by some 

PowerPoint conversion tools. 

With Adobe Presenter® 

The Adobe Presenter® PowerPoint plug-in allows you to add true/false, multiple-choice, and 

multiple-answer quizzes. These quizzes may communicate with a learning management system 

using either AICC or SCORM protocols. 

These quizzes are represented in your PowerPoint file by a quiz placeholder. When the file is 

published for Web delivery, each quiz is built and the entire file is converted to Shockwave 

Flash®. 

With Articulate Presenter® 

If you own Articulate Presenter®, the Articulate PowerPoint plug-in allows you to add true/false, 

multiple-choice, sequence, or word game (like hangman). These quizzes may communicate with 

a learning management system using either AICC or SCORM protocols. 

In addition, Articulate has a standalone program called Quiz Maker in which you can create a 

wider variety of assessments, which also can communicate with a SCORM-compliant 

LMS/LCMS. These assessments can then be integrated into your PowerPoint file. 

Articulate’s quizzes are represented in your PowerPoint file by a quiz placeholder. When the file 

is published for Web delivery, each quiz is built and the entire file is converted to Shockwave 

Flash®. 

With iSpring Presenter® 

The iSpring Presenter® PowerPoint plug-in allows you to insert ten types of quiz questions – 

including cloze questions. These quizzes may communicate with a learning management system 

using either AICC or SCORM protocols. 
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These quizzes are represented in your PowerPoint file by a quiz placeholder. When the file is 

published for Web delivery, each quiz is built and the entire file is converted to Shockwave 

Flash®. 

With a separate test-creation tool or service 

You can also create assessments using a variety of authoring tools and services, and then link to 

the assessments from within PowerPoint. 

Tools and services for creating external assessments 

Here are some popular tools used to create assessments: 

 Adobe Captivate® is a desktop tool most often used to create software simulations. 

However, it also makes it easy to create a variety of test questions as well as scenario-

based activities. Go to http://www.adobe.com/captivate. 

 Questionmark Perception® is a server-based tool that allows you to create, deploy, and 

administer a variety of question types. Questionmark Perception is SCORM 1.2 

compliant and may be integrated with certain LMSs and LCMSs. Go to 

www.questionmark.com for more information. 

 Hot Potatoes from Half-Baked Software is a desk-top tool that produces a variety of 

question types in the Java. Results can be reported to a server using CGI script or sent to 

an individual via e-mail. Go to http://hotpot.uvic.ca for more information. 

 Random Test Generator-PRO from Hirtle Software is a desktop tool that allows you to 

create a wide variety of question types using HTML and JavaScript. Go to 

http://www.hirtlesoftware.com for more information. 

 QuizPoint from LearningWare, Inc. is an online service that allows you to create a 

variety of question types in the Flash® format and administer their delivery. Results can 

be sent to you via e-mail, or you may select to have users' results written to the database 

of your choice. Go to http://www.learningware.com for more information. 

 Hosted Test® from HostedWare, Inc. is an online service that allows you to create a 

variety of question types and administer their delivery. Go to http://www.hostedtest.com 

for more information. 

For more testing tools, go to horton.com/tools. 

Linking to external assessments 

You link to assessments in the same manner you would link to any other external resource. 

1. Insert a blank slide with the title of your activity. 

2. Add a link trigger, such as a screen shot of the assessment or just some text. 

3. Right-click on the screen shot or text and select Hyperlink…. 

4. Type in the URL to the assessment. The URL can be relative or complete. If you use a 

relative URL (one that is based on the location of the presentation), the assessment must 

always be located in the same location relative to the converted PowerPoint file. If you 

use a full URL (http://www.something.com/whatever), the assessment can be anywhere 

on the Internet. 

http://www.adobe.com/captivate
file:///C:/Users/Public/Documents/Kits_projects/PPT_Templates_Office2010/presensational_templates/Presensational_Learning_Slides/www.questionmark.com
http://hotpot.uvic.ca/
http://www.hirtlesoftware.com/
http://www.learningware.com/
http://www.hostedtest.com/
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With an LMS/LCMS testing module 

Many LMSs and LCMSs provide tools for creating assessments. Once created, there are a variety 

of ways to make them available to learners. How you choose to do it will depend upon the 

management system you are using and the procedures you have in place for authoring and 

delivering courses.  

With informal self-check activities 

If you do not need scores or other types of data, then consider building self-check activities 

within PowerPoint. 

The Presensational Content Template Slides (sold separately) contain templates for building a 

number of self-check activities. They contain matching, multiple-choice, true/false, short-answer, 

and click-in-picture activities. 

You can purchase the Presensational Content Template Slides at http://www.horton.com. 

CONVERSION NOTES 

If you are creating courses for Web delivery, you need to think about how to convert them so that 

they are Web-friendly. In this section are some conversion tools you may want to consider. To 

learn more about them, go to their respective Web sites. 

Conversion methods and tools 

This is not an exhaustive list of conversion methods. For more, go to www.horton.com/tools. 

 Save As  HTML (Web page) command from within PowerPoint, office.microsoft.com 

 PowerPoint Producer 2007 is available from connect.microsoft.com 

 Articulate Presenter, www.articulate.com 

 Adobe Presenter, www.adobe.com 

 iSpring Presenter, www.iSpringsolutions.com 

 Impatica for PowerPoint, www.impatica.com 

 PowerConverter, www.presentationpro.com 

Issues to consider 

When choosing a conversion method to make PowerPoint Web-ready, here are some issues to 

consider: 

 What PowerPoint features are preserved?  

 Does the tool produce HTML, Java, Flash, Windows Media, Real Media, or a 

combination of these formats?  

 What player is required? 

 Can narration be tightly synchronized with animation? 

http://www.horton.com/
http://office.microsoft.com/
http://connect.microsoft.com/
http://www.articulate.com/
http://www.adobe.com/
http://www.impatica.com/
http://www.presentationpro.com/
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 What is the file format of the converted audio? For instance, is it converted to a web-

ready format like MP3? 

 Is the conversion method a product or service? 

 Does the conversion tool or method add additional features—like assessments, table of 

contents, functional interface, or administrative tools? 

REVIEW THE BASIC POWERPOINT SKILLS YOU WILL NEED 

This section contains instructions for the tasks you will need to perform to get the most from 

these templates. This is not a tutorial on PowerPoint but just a quick reminder of some crucial 

procedures. These instructions are for PowerPoint 2007.  

Delete unneeded objects 

Select the object you want to delete, and then hit the Delete key. Alternatively, from the Home 

tab, select Cut. 

Duplicate slide objects  

You often must duplicate existing slide objects. To do so simply:  

1. Select the object you want to duplicate.  

2. Hold down the Ctrl key and press the D key. The copy will appear a little to the right 

and a little below the original object. And, it will be selected. 

Group objects 

You will often need to group a number of objects together so that they can be manipulated as one 

object. Here’s how: 

1. Select the first object you wish to group. 

2. Hold down the Shift key and select the other objects you want to add to the group. 

3. On the Home tab, click Arrange in the Drawing section of the Home ribbon 

4. Select Group.  

Even easier:  

1. Select the items to group. 

2. Right-click and choose Group in the context menu. 

3. Then choose Group in the submenu. 

For you power users out there, there is a Selection and Visibility pane that displays a list of all 

the objects on your slide. You can use it to check the items you want to select. This is useful if 

some of the items you want to select are behind other objects. It is available from the Select menu 

item on the Home ribbon. 
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Ungroup objects 

This one is really easy. Just click on the group. Right-click, choose Group, then choose Ungroup 

in the submenu. 

Tip: If you wish to group the items again, just select one of the items in the old group, right-click 

and choose Group, then Regroup. 

Edit text in placeholders 

Edit placeholder text or sample text as you would in Microsoft Word®. 

1. Place your cursor right before the first letter of the first word of the text you want to edit. 

2. Hold down the Shift key. 

3. Place the cursor after the last letter of the last word of the text you want to edit. (All the 

text should be highlighted.) 

4. Edit the text. 

Shortcut: Another way to select text is to double-click to select a whole word, Ctrl-click to select 

an entire sentence, or triple-click to select an entire paragraph. 

Change text color 

 You can change the color of a letter, a word or group 

of words, or a text box. Simply select what you want to 

recolor, and then click the downward-pointing arrow 

next to the font color button in the floating formatting 

pallet. 

Either select one of the colors shown or click More 

Colors… to choose another color. 
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Change line color 

 Just as you can change font 

color, you can also change the 

line color of text and drawing 

objects. Simply select what you 

want to recolor and then right-

click and choose Format Shape. 

In the Format Shape dialog box, 

make the changes you wish. 

Notice how many characteristics 

you can control from this one 

dialog box! 

You can also change line color 

by clicking the Shape Outline 

button tab in the Drawing 

section of the Home ribbon. 

 

 

Change fill color, fill effect, and transparency 

You can easily change the fill color for text and drawing objects. Just select what you want to 

recolor, right-click, and choose Format Shape. In the Format Shape dialog box, you can change 

the fill color, fill effects, and fill transparency. 

Experiment with these options to see how they work.  

Arrange objects 

As you add objects on a slide, you will often 

need to change their front-to-back order. That 

is, you must control which object appears in 

front of or behind other objects. This is an 

easy process.  

1. Select the object you want to change. 

In this example, we want to move the 

small block out from behind the large 

block—that is, bring the small block to 

the front.  

2. Select the small block and right-click. 

3. Choose Bring to Front from the context menu. 

4. Then, choose Bring to Front from the submenu. 

5. Adjust the position of the small block and you’re done. 
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Adjust animation order 

As you modify the template slides, you will often have to change in what order objects on your 

slide animate. Animation refers to how objects first 

appear, disappear, move, or change characteristic on a 

slide. 

Take a look at the example to the right. The bottom block 

wipes on before the arrow. We need to change the 

animation order of the arrow:  

1. Click the Animations tab. 

2.  Select Custom Animation in the Animations 

section of the ribbon to display the Custom 

Animation panel docked to the right side of the 

PowerPoint window. 

3. On the slide, select the object whose animation 

order you want to change—in this case the arrow.  

4. Select the highlighted object in the Custom Animation panel. Notice that it is now 

bordered in blue.  

5. Using the Re-Order arrows near the bottom of the Custom Animation panel, move the 

selected object up or down into the desired order—in this case we will move the arrow 

(labeled Right arrow 3) up just before the bottom block (labeled Rectangle 4). 

Caution: Some objects may have multiple animations. When you select them on the slide, more 

than one item will highlight in the Custom Animation panel. Make sure you select just the item 

you want to reorder before making any changes. 

Adjust animation direction 

As you customize these template slides, you will need to 

change the direction of an animation effect. For instance, 

if you use arrows to show how a process flows left to 

right, you want to make sure that the arrows all wipe 

left to right. In PowerPoint parlance, left-to-right is 

called “From Left.” 

1. On the slide, select the item whose animation 

direction you want to change. 

2. Display the Custom Animation panel. 

3. Next to Direction:, click the downward-pointing arrow to see the direction choices you 

have. 

4. Select the appropriate direction. 

Note: Not all animation effects have directions.  


